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1. Copyrights

© 2010 Enfocus NV all rights reserved. Enfocus is an EskoArtwork company.
Certified PDF is a registered trademark of Enfocus NV; patent pending.

Enfocus PitStop Connect, Enfocus PitStop Pro, Enfocus PitStop Server, Enfocus Instant PDF, Enfocus
StatusCheck, Enfocus CertifiedPDF.net, Enfocus Instant Barcode, Enfocus PitStop Extreme, Enfocus
PDF Workflow Suite, Enfocus LightSwitch, Enfocus FullSwitch, Enfocus PowerSwitch, Enfocus
Switch(Client and Enfocus SwitchScripter are product names of Enfocus NV.

Acrobat, Distiller, InDesign, lllustrator, Photoshop, FrameMaker, PDFWriter, PageMaker, the Adobe
logo, the Acrobat logo and PostScript are trademarks of Adobe Systems Incorporated.

Macintosh, Mac, Mac 0S and ColorSync are trademarks of Apple Computer, Inc., registered in the
U.S. and other countries.

Windows, Windows 2000, Windows XP and Windows Vista are registered trademarks of Microsoft
Corporation.

PANTONE® Colors displayed here may not match PANTONE-identified standards. Consult current
PANTONE Color Publications for accurate color.

PANTONE® and other Pantone, Inc. trademarks are the property of Pantone, Inc. ©Pantone, Inc.,
2006.

0Pl is a trademark of Aldus Corporation.

Quark, QuarkXPress, QuarkXTensions, XTensions and the XTensions logo among others, are
trademarks of Quark, Inc. and all applicable affiliated companies, Reg. U.S. Pat. & Tm. Off. and
in many other countries.

This product and use of this product is under license from Markzware under U.S.Patent No.
5,963,641.

Other brand and product names may be trademarks or registered trademarks of their respective
holders. All specifications, terms and descriptions of products and services are subject to change
without notice or recourse.
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2. Introduction

2.1 Welcome to PitStop Connect

Thank you for your interest in Enfocus PitStop Connect.

PitStop Connect was created because there was a need for a simple, user-friendly method to
create and deliver Certified PDFs.

We strive to make our products user-friendly and easy to learn. If you think we could do more
with the product, the documentation, our web site or anything else to make your life easier, we
would love to hear about it.

2.2 Using PitStop Connect help

Displaying Help

Choose Help > PitStop Connect help (html) in the Enfocus PitStop Connect application menu to

view the PitStop Connect User Guide. PitStop Connect uses your default web browser to display
its help content.

Knowledge base

The Knowledge base contains articles with answers to frequently asked questions, work-arounds
and tips & tricks. To access the knowledge base, go to: www.enfocus.com/kboverview.php.

Getting support

If you cannot find the answer to your question in PitStop Connect help or on the web, help is
available from the Enfocus support team.

Before asking your question please:

Consult the product documentation (PitStop Connect User Guide) and the on-line resources
available on www.enfocus.com (knowledge base, application library).

+ Consider to gain advice from your peers on the Enfocus user group.
+ Register your product - this will help us to know who you are and what products you are
using.

To contact Enfocus Support: complete and submit the "report a problem" form on the web at
http://www.enfocus.com/reportaproblem.php.
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3. Installing and running PitStop Connect

3.1 Getting ready to run PitStop Connect

System requirements

You can find the system requirements on the Enfocus website http://www.enfocus.com by choosing
Products > PitStop Connect > System Requirements

Locating the installer from a product DVD

1. Insert the DVD in the DVD drive of your system

2. The DVD wizard appears and shows you the content of the DVD. Follow the steps in the wizard
to find the installer

Downloading the installer from internet

To download the latest version of the installer:

1. Visit the Enfocus web site and go to the Product > PitStop Connect section.
2. Download the appropriate installer for your operating system.

3. Locate the installer where you saved it on your computer.

Installing PitStop Connect

1. Double-click the installer to launch it.

2. Follow the steps presented to you by the installer.

Note: You need administrator rights to install and license PitStop Connect. In other words, you
can't successfully complete these tasks when you're logged in with a limited user account.

3.2 Running PitStop Connect for the first time

To run PitStop Connect, you will need your license key to license the application first.
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3.3 Licensing

From the About Enfocus PitStop Connect window, you can:
start a 30-day trial (see Starting a trial on page 7),
activate your license (see Activating licenses on page 8),

+ deactivate your license,

* repair your license.

For easiest configuration, the machine running your PitStop Connect should be on-line with full
Internet access while performing licensing tasks.

However, if the machine you are using does not have full Internet access, you can still perform
licensing tasks off-line provided that you:

+ have access to Internet e-mail and use of a Web browser on another machine,

can copy a file received in an Internet e-mail message to the machine you are using (for
instance using a USB flash memory drive or an internal network).

Before you can activate or deactivate licenses, you should set up an activation account using
the Enfocus website (http://www.enfocus.com/CreateAccount).

Creating an activation account

1. Go to http://www.enfocus.com/CreateAccount.
2. Enter the appropriate information in the fields.

3. If you would like to receive news from Enfocus or be contacted by an Enfocus Certified Partner,
leave the two bottom checkboxes selected; otherwise, clear them.

L. Click Create my Account.

5. After a few minutes, check your e-mail program for a new message from Enfocus regarding
activating your new account.

Note:

If you do not receive this e-mail message, you might have to check any spam folders in your
e-mail program as well.

6. Once it arrives, open the message and click the link to confirm your e-mail address.

You should receive a message that your account was confirmed successfully in your default
web browser.
Starting a trial

Once you have created and confirmed your activation account (see Creating an activation account
on page 7), you can start a 30-day trial for your copy of PitStop Connect. Please note that the
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PitStop Connect trial version does not allow the user to use Connectors on a system other than
the one that generated them. This means you can only use Connectors on the machine with your
PitStop Connect installation.

+ If the computer running your PitStop Connect is connected to the Internet, you can start a
30-day trial from that machine.

See Starting a trial on-line on page 8

Otherwise, you must create a trial activation request file and use a computer that is connected
to the Internet to upload it to an activation server.

Starting a trial on-line

You can start a 30-day trial on-line if the computer where your PitStop Connect is installed is
connected to the internet.

To start a 30-day trial on-line, do the following:
1. Go to the Trial tab of the About Enfocus PitStop Connect window and click Start Trial.

This opens the Activate License Wizard (on PC) or the Activate License Assistant (on Mac).

2. Click Next (on PC) or Continue (on Mac) in the first screen of the Activate License
Wizard/Assistant dialog box.

3. Select On-line activation and click Next / Continue.

L. Enter the name and password of your activation account and click Next / Continue.

Note:

If you haven't created an activation account yet, click the Create a new Enfocus Account link
in the Wizard/Assistant and see Creating an activation account on page 7 for instructions.

After you click Next / Continue, a status bar appears while the system communicates with the
activation server. Do not cancel or close the Wizard/Assistant.

A message will appear saying that the trial was completed successfully and that you can now
use the product(s) on your computer.

5. Click Finish / Done.

You will see the number of trial days remaining in the Trial tab of the About Enfocus PitStop
Connect window.

Activating licenses

Once you have created and confirmed your activation account (see Creating an activation account
on page 7), you can start activating the licenses using your software's product keys.

Product keys come from on-line stores, from product key files you receive from Enfocus, or you
can find them inside product boxes.

Note: Product key files are HTML files. You can double-click them to see what product keys they
contain.
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+ Ifthe computer running your PitStop Connect is connected to the Internet, you can get licenses
for the product keys and activate them from that machine.

See On-line activation on page 9

Otherwise, you must create an activation request file and use a computer that is connected
to the Internet to upload it to an activation server.

On-line activation

You can activate your product key(s) on-line if the computer where you will use your software
is connected to the internet.

To activate a product key on-line, do the following:
1. Open the Activate License Wizard (on P() or the Activate License Assistant (on Mac) by either:

+ going to the Trial tab of the About Enfocus PitStop Connect window and clicking Activate,

going to Help > Licensing > Activate .

2. Click Next (on PC) or Continue (on Mac) in the first screen of the Activate License
Wizard/Assistant dialog box.

3. Select On-line activation and click Next / Continue.

L. Enter the product key in the fields provided. The cursor automatically advances to the next
field as you type.

5. Click Next / Continue.

6. Enter the name and password of your activation account and click Next / Continue.

Note: If you haven't created an activation account yet, click the Create a new Enfocus Account
link in the Wizard/Assistant and see Creating an activation account on page 7 for instructions.

After you click Next / Continue, a status bar appears while the system communicates with the
activation server. Do not cancel or close the Wizard/Assistant.

A message will appear saying that the activation was completed successfully and that you
can now use the product(s) on your computer.

7. Click Finish / Done.

The product and its license will appear in the License tab of the About Enfocus PitStop Connect
window (previously called Trial tab).

Moving licenses between computers

To move licenses between computers, do the following:
1. Deactivate the licenses on the computer that will not use them anymore.
2. Copy the product keys file to the computer that will use the licenses.

3. On the computer acquiring the licenses, activate the licenses using the product keys file.
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See Activating licenses on page 8.

10
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L. Finding your way around PitStop Connect

With PitStop Connect, you can generate Connectors used to create and deliver Certified PDFs,
regular PDF files or even other files. You specify the settings for a Connector in a Connector project.
You can define multiple PitStop Connectors.

4.1 PitStop Connect: the general concept

Using PitStop Connectors, you can facilitate and streamline the way other people send files to
you:

You can define Action Lists to be applied on PDF files before sending.
You select a Preflight Profile by which PDF files will be preflighted before sending

* You can have files sent to you by simple dragging and dropping, using FTP or sending directly
to an Enfocus Switch Server. The address and credentials (user name, password) can be stored
in the PitStop Connector

Note:

When using FTP delivery, you need a login and password with "Write only" privileges to be
included in the Connector.

To set up a PitStop Connect workflow you follow these steps:

1. You configure and create a PitStop Connector using PitStop Connect.

2. Next, you distribute this PitStop Connector to the "clients": customers, creative designers,
authors, or anyone else who needs to send you files.

Note:

A PitStop Connector is a standalone application, so it doesn't need PitStop Connect to run.

3. Your clients can now drop files on this PitStop Connector. These files will then be processed
and sent to you, based on the settings you made.

Updating Connectors
The Automatic Updating system is optional.

It allows you to ensure that all your clients are using the latest version of a PitStop Connector.

1. When configuring the PitStop Connector, you add FTP settings: the server address, the login
credentials for uploading the Connectors, and the login credentials for the clients.

2. When creating the Connector, it will be copied to the FTP server, including version information,
using the Upload FTP settings (user name and password).

n
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3, If your client runs the PitStop Connector, it will connect to the FTP server (using the Download
user name and password), and compare its version with the one on the FTP server:

+ If the version is the same, the client can continue using the Connector

+ If there is a new version, the client will be prompted, including a link to the FTP location
where a new version can be downloaded. During the grace period, the client is allowed
to continue using the previous version. After the grace period, or if the client was using
an older version, the Connector will no longer work.

+ If you removed the Connector and its information from the FTP server, the Connector is
considered to be obsolete, and it will no longer work.

+ If the Connector can't reach the FTP server, a warning is given, but the Connector will
continue to work.

To use the Automatic Updating system, you need:
an FTP server.

Note: This can be the same as the Delivery FTP server, but this is not obliged. It is however
advised to use at least a different directory.

+ Alogin for PitStop Connect to upload the Connector and version information. This Version
Upload login needs Read/Write access.

- Alogin for the Connectors (to check versions, and allow client to download new versions). It
is advised to restrict the privileges of this login to "Read only".

Note:

If you use the Automatic Update system in combination with FTP delivery, it is advised to use 3
different logins: one for the Delivery (with "Write Only" privileges"), one for the Version Upload
(with Read/Write privileges) and one for the Version Check (with "Read Only" privileges).

4.2 PitStop Connect application components

Main window overview

When you launch PitStop Connect, it displays its main window:

12
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800 PitStop Connect —

| Connector projects | [ Definition | Window Preflight Color Delivery Update |

« MNew project 1

Name: |New project 1| |

Version: Major: 1 @ Minor: 0 @

lcon: [ Browse... |

The main window contains the following elements:

* the Toolbar (see Toolbar on page 13)
* the Projects list (see Connector projects list on page 14)
* the Project properties area (see Connector project properties on page 15)

Also see the entry about the Menu on page 15.
Toolbar

At the top of the main window, you can find the PitStop Connect toolbar, which offers a number
of tool buttons:

R

The following table provides an overview of the tool buttons and their functions:

Button Name Function
- New Connector project Create a new Connector project. This new Connector
‘n project will appear in the Connector projects list.

13
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Button Name Function
| — i

. Remove Connector project Remove the selected Connector project.
I8

I 'Ll'r Duplicate Duplicate the selected Connector project. The copy
L is named "OriginalProjectName copy".

| Create connector

Create the Connectors defined by the Connector
ﬁ project. Two Connectors will be created; one for
Windows and one for Mac 0S.

[—=

Connector projects list

In PitStop Connect, you can define multiple PitStop Connector projects. On the left side of the
main application window, you can find the projects list:

Connector projects
Mew project 2
Mew project 3
Mew project 4

Select a project in the list to see its properties in the Connector project properties area (see also
Connector project properties on page 15).

Context menu

Right-click or control-click on a project in the list to use the context menu. The following table
provides an overview of the actions available from the context menu:

Context menu item Function

18 New Create a new PitStop Connector project. This new Connector project
will appear in the Connector projects list.

i Remove Remove the selected project.

=

11 Duplicate Duplicate the selected project. The copy is named
"OriginalProjectName copy".

Tk Create Connector Create the PitStop Connector defined by the project.

14
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Menu

Connector project properties

In the central area of the PitStop Connect main application window, you will find the project

properties. Select a Connector project in the Connector projects list (see also Connector projects
list on page 14) to view and edit all properties for this project:

[ Definition Window Preflight Color Delivery Update

Name: New project 1

-

Version: Major: 1 E] Minor: 0

Icon: | Browse... )

The properties are devided into several categories. The following table provides an overview of
the property categories:

Category Properties

Definition Properties to identify the PitStop Connector. The name of the
resulting Connector, the icon for both Mac 05 and Windows (*.png).
If no icon is set, the default icon is used.

Window Properties for the PitStop Connector's main window. These include
the title, a description, a web link and a background image.

Preflight Properties that determine which Preflight Profile should be used to
Certify the PDF and, optionally, which Action List(s) should be
applied.

Color Properties for Color Management. Source and target ICC Profiles for
Gray, RGB, CMYK and Lab.

Delivery Properties that determine how the file is delivered. Two delivery
methods are available: Enfocus Switch and FTP. Properties include:
server, port, user and login.

Update

Properties that determine how the Connectors are updated if an
update is available

See also Setting the project properties on page 18.

PitStop Connect

The PitStop Connect application menu contains the following items:

Choose Quit PitStop Connect (Mac) or Exit PitStop Connect (Windows) to leave the application.

15


http://www.renderx.com/
http://www.renderx.com/reference.html
http://www.renderx.com/tools/
http://www.renderx.com/

Enfocus PitStop Connect

Choose Preferences... to alter your PitStop Connect preferences.

File

The following table lists the options available from the File section of the menu:

1!V puplicate

=]

I-8@ Remove

=1

I“N Create Connector

Menu item Function
1o New Create a new PitStop Connector project. This new Connector project

will appear in the Connector projects list.

Duplicate the selected project. The copy is named
"OriginalProjectName copy".

Remove the selected project.

Create the PitStop Connector defined by the project.

Help

Choose PitStop Connect help (html) or Knowledge base to go to the PitStop Connect help files

among others.

16
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5. Creating a Connector project

Before you create a Connector, you need to define a Connector project. There are two ways to do
this. You can create a new Connector project, or, you can duplicate an existing project and edit
this project.

After you have finished setting the project properties, you can create a PitStop Connector.

See also:
Creating a new project on page 17
To duplicate a project on page 23
+ To edit a project on page 24
Setting the project properties on page 18
To create a PitStop Connector on page 21

5.1 Creating a new project

In order to create a new PitStop Connector, you first need to create a new Connector project. In
this project, you specify all the desired settings for your Connector. Once you have finished
creating your project, you can generate a PitStop Connector for this project (see also To create a
PitStop Connector on page 21).

The Connector projects are stored automatically on your system in the user application support
folder for PitStop Connect. Any modification on a project is saved immediately.

Note:

You can find the user application folder here:

« [/ Users/<user>/Library/ Application Support/Enfocus/PitStop Connect (Mac
0S)

+ \ User s\ <user >\ AppDat a\ Roani ng\ Enf ocus\ Pi t St op Connect (Windows Vista,
Windows 7)

* \Docunents and Settings\<user>\Application Data\Enfocus\PitStop Connect
(Windows XP, Windows Server 2003)

To create a new project

To create a new PitStop Connect project, do one of the following:
Click the 1 button in the PitStop Connect toolbar

Right-click/command-click on the Connector projects list (see Connector projects list on page
14) and choose New from the context menu

* Choose File > New in the application menu

Note:

17
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After you have created a new project, you can start setting the project properties for your new
PitStop Connect project (see also Setting the project properties on page 18).

5.2 Setting the project properties

In the PitStop Connect project properties, you can set the following properties for your project:

Definition (see also Definition properties on page 18)
Window (see also Window properties on page 18)

*  Preflight (see also Preflight properties on page 18)

* Color (see also Color properties on page 19)

* Delivery (see also Delivery properties on page 20)
Update (see also Update properties on page 21)

Definition properties

The Definition properties are needed for identifying your PitStop Connector. These properties
determine the name of your Connector and the desired application icon.

1. Enter the name for your Connector in the Name field.

2. Specify an application icon for your Connector in the Icon field. Click Browse... to select a
*.png file on your system. Best size for an icon is 128 by 128 pixels. If no icon is specified, a
defalt icon will be used.

Window properties

The Window properties are used for the main window of your PitStop Connector. These properties
determine the look of your Connector.

1. Enter the title for your main Connector window in the Title field.
2. Enter more specific information about your Connector in the Description field.
3. Enter an url in the Link field. This web link will be clickable in the main Connector window.

L. Use a Link alias to choose an alternative text for the link, e.g. "Company Website". If no Link
alias is entered, the link url will be shown.

5. Specify a background image for your PitStop Connector in the Background field. Click Browse...
to select an image file (*.png) on your system. Best size for a background image is 620 by 418
pixels. If nothing is specified, a default Enfocus background image will be used.

Preflight properties

In the Preflight properties you determine which Action List(s) and Preflight Profile are used for
preflighting. You can use Action Lists and Preflight Profiles from the standard set installed with
PitStop Connect, or you can download Action Lists and Preflight Profiles from the Enfocus web
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site, or create your own using PitStop Pro, PitStop Extreme or PitStop Server. You can also create
or edit Preflight Profiles from within in PitStop Connect.

See also:

About Action Lists on page 30
About Preflight Profiles on page 29

. In the Selected Action Lists area, click the (# button to add your desired Action List(s) to the

list.

Note:
Use the = button to remove an Action List from the list.

Use the = and = buttons to move the selected Action List one position up or down in the list.
The Action Lists will run in the same order as they are displayed in the list. This order can be
important, changing the order might lead to different results.

In the Selected Preflight Profile area, click the =/ button to add your desired Preflight Profile
to the list. This step is mandatory, you cannot create a Connector without selecting a Preflight
Profile.

Note: Use the = button to remove a Preflight Profile.

Disable Perform Certified full save (no rollback to previous sessions if you wish to enable
roll-back.

Enable Allow Sign-off on files if you want the user of your Connector to be able to Sign 0ff
on the failed Preflight.

Color properties

The Color properties are used for Color Management.

1.

Select Use other settings for images than for other objects if you want to use separate Color
Management settings for images and other objects. If you do so, repeat the following steps
for both the Images and Other objects tab.

Make sure Enable color management is enabled if you want to use Color Management and
continue performing the following tasks:

a) In the Source area, choose the desired ICC profiles for Gray, RGB, CMYK and Lab.

Note: Optionally enable The output intent overrides the selected ICC profiles.

b) Optionally enable Use other ICC profile than source and choose the desired ICC profiles for
Gray, RGB, CMYK and Lab in the Target area.

Note: Optionally enable The output intent overrides the selected ICC profiles.

¢) Choose a (MM engine from the CMM engine list. You can choose one of the following:
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« Adobe CMM (can be downloaded from the Adobe web site)
+ System CMM
Little CMM

d) Choose a rendering intent to remap colors from the Rendering intent list. You can choose
one of the following remapping methods:
+ Object defined

+ Relative colorimetric: replaces colors outside of the gamut by colors with the same
lightness, but different saturation.
Absolute colorimetric: clips colors outside of the gamut to a color on the gamut
boundary. Colors which cannot be displayed in the target color gamut will be lost.

« Saturation: scales all colors to the brightest saturation possible. The saturation (also
called chroma) will remain the same, but some colors will appear lighter or darker.

+  Perceptual: rescales the original gamut within the gamut of the destination color space,
but preserves the relationship between colors.

Delivery properties

The Delivery properties are used to specify how the files dropped on a Connector are delivered.

1.

2.

5.

Enable Allow non PDF files if you are willing to accept any file, not just PDF files. Non PDF
files will not be preflighted before delivery.

Enable Compress if you want the files to be compressed before delivery.

. Enable Use password to encrypt the compressed file with the password specified in the

Password field.

In the Delivery method list, choose either Enfocus Switch or FTP, depending on which delivery
method you prefer.

Specify the Server DNS name in the Server field. Include the domain name.

Note:
« An example for Switch delivery: "SwitchServer.enfocus.com".

« An example for FTP delivery: "ftp.enfocus.com".
« Entering an IP address is also possible.

Specify the Port.

Switch: Specify the port Switch server is using for its client connection.
+ FTP: Specify the port the FTP server is using. The default port is 21.

In the Login type list, select one of the following options:
+ Use specified credentials above: Continue to enter the specific login data in the User and
the Password fields. The Connector will not ask the user for a user name or password.

Ask password only: Continue to enter the specific user name in the User field. The Connector
will ask the user for the password.
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+ Ask user and password: The Connector will ask the user for a user name and a password
to login.

8. Specify your Directory or Submit point settings:

a) If you chose FTP delivery, specify the Directory in which the file should be placed. Click
the Browse... button and select a directory on your system, or enter a directory in the
field. Enable Passive mode, if you want to use passive mode to connect to the FTP server.

b) If you chose Enfocus Switch delivery, select the Submit point from the list. If your desired
submit point is not listed, click the Refresh button to refresh the list.

9. Optionally enable Perform Certified full save (no rollback to previous sessions).
10. Specify which actions you wish to allow:

Enable Allow Sign-off on files if you want to enable your client to Sign 0ff on Preflight
errors.

Enable Allow delivery of PDF files that are not Certified OK if you are willing to accept
files of which the Preflight report contains errors.

Update properties

The Update Properties allow to configure the settings for automatically updating the Connector.
For more information, see Updating Connectors on page 1. '

In the Update tab, you can define:
* The FTP server to be used, including the Server port and Passive mode
The login, password and directory to upload the Connector and version info.

The login, password and directory for download. The Connector can use these to check the
version and allow downloading newer versions.

* The Identity for the connector. The name of the Connector is used by default. After uploading,
this field can not be modified anymore.

* The Version number, based on a Major and Minor number. Every time a Connector is uploaded,
the Minor version number will be increased by 1.

* The Grace period. During this grace periods, your clients will be able to use the previous
version of the Connector. After that, only the newest version will work.

5.3 To create a PitStop Connector

After setting all the properties for your Connector project, you can create a PitStop Connector. To
create a PitStop Connector do one of the following:

Select the Connector project and click the X button in the PitStop Connect toolbar

* Right-clickicommand-click on a project in the Connector projects list and choose Create
Connector from the context menu
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Select the Connector project and choose File > Create Connector in the application menu

If the Automatic Updating system is used (see Updating Connectors on page 11), you will get
the option to upload the Connector to the FTP server. This allows to test a connector before
uploading it to the FIP server.

Note:

If certain property fields have not been filled out (correctly), the following message will be
displayed: "The following errors occurred in your connector project: <errors> Therefore the
connector can't be created.". If this happens, carefully read the instructions in the dialog,
click OK and fix the problems.

When you create a Connector, you actually create two files. One Connector to be used on
Windows and one for Mac 0S.
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6. Managing Connector projects

Your current Connector projects are displayed in the Connector projects list (see also Connector
projects list on page 14). Connector projects are stored automatically on your system in the user
application support folder for PitStop Connect. Any modification on a project is saved immediately.

Note:

You can find the user application folder here:

« [ Users/<user>/Library/ Application Support/Enfocus/PitStop Connect (Mac
0s)

+ \ User s\ <user >\ AppDat a\ Roani ng\ Enf ocus\ Pi t St op Connect (Windows Vista,
Windows 7)

+ \Docunents and Settings\<user>\Application Data\Enfocus\PitStop Connect
(Windows XP, Windows Server 2003)

You can do the following with your Connector projects:

Remove (see To remove a project on page 23)
Duplicate (see To duplicate a project on page 23)
Edit (see To edit a project on page 24)

You can also create a new project (see also To create a new project on page 17).

6.1To remove a project

To remove a Connector project do one of the following:

Select the project in the projects list and click the Remove L8 putton in the PitStop Connect
toolbar.

Right-click or control-click the project in the projects list and choose Remove from the
context-menu.

Select the project in the projects list and choose File > Remove .

6.2 To duplicate a project

To duplicate a Connector project do one of the following:

e
Select the project in the projects list and click the Duplicate ! ' button in the PitStop Connect
toolbar.

Right-click or control-click the project in the projects list and choose Duplicate from the
context-menu.
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Select the project in the projects list and choose File > Duplicate .

6.3 To edit a project

To edit a Connector project:

1. Select the project in the projects list.

2. Edit the desired properties. See Setting the project properties on page 18.

Note:

PitStop Connect projects are saved automatically.
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7. Using a PitStop Connector

7.1 Getting started

To install a PitStop Connector
To install a PitStop Connector
1. Download the PitStop Connector and place it on your desktop.

2. The PitStop Connector is now ready to use.

Note:

PitStop Connectors can be used on both Windows and Mac 0S. Make sure you install the correct
version.

To uninstall a PitStop Connector, simply remove it from your desktop.

Check for updates
The Connector can be set to check for updates when the Connector is launched. To perform this
check, the Connector will connect to an FTP server defined in the Connector.
If you are using the most recent version, the Connector will launch normally.

If there is a new version, you will notified, and a link to the FTP location where a new version
can be downloaded is provided. During a defined grace period, you are allowed to continue
using the previous version. After the grace period, or if you are using an older version, the
Connector will no longer work.

If the Connector is obsolete, you will get a warning, and the Connector will no longer work.

If the Connector can't reach the FTP server, a warning is given, but the Connector will continue
to work.

7.2 PitStop Connector components

Window overview

After double-clicking on a PitStop Connector, you see its main window. The main window typically
contains a title, a short description and a web link:
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| 8‘00 S Upload to Enfocus

This is a default Enfocus Connector.

www.enfocus.com

Powered by Enfocus (BETA version)

You can drag and drop files on the main window. These files can then be preflighted and delivered
to your publisher or printer.

Menu

The PitStop Connector menu contains the following items:

Drop

Open a file to have it processed by the Connector. This has the same behavior as looking for a
PDF in Finder or Explorer and then dragging and dropping it on the Connector.

Quit/Exit
Close the Connector.

Help
Access the PitStop Connector help files or visit the Enfocus home page.

7.3 Using a PitStop Connector to send a PDF file

With a PitStop Connector you can send PDF files. PitStop Connectors are created with specific
Preflight and delivery settings to make sure your PDF file will be ready to print. If the Connector
is defined as such, your PDF file can be Certified before sending.

You start out with your own PDF, which you drop on the PitStop Connector. The Connector will
take care of Preflight and Color Management and deliver your files to your printer or publisher.

To drop a file on a Connector

1. If you want the Connector to process your PDF file, you need to drop your file on it. There are
a couple of ways to do this:

a) Locate your PDF file in Finder or Explorer and drop it on the Connector icon.
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b) Double-click the Connector icon to open its main window. Drop your PDF file on this
window.

¢) Double-click the Connector icon to open its main window. In the Connector menu, choose
Drop and select your PDF file.

2. After you have dropped your file on the Connector, you might have to enter a login and/or
password to deliver your file.

3. Next, the Action Lists defined in the Connector will be executed, and the file will be preflighted.
You can interrupt this by clicking the Cancel button

L. According to the result of the preflighting, you can have different options:
The Cancel button closes the window, and cancels all actions
The View Report button allows to inspect the Preflight report.

The Sign-off button allows to sign off on errors. See To Sign Off on Preflight errors on page
28. This button is only available if the preflight contains errors, and if Sign-off is enabled
(both in the Preflight Profile as in the Connector setup). However, if not all errors can be
Signed Off or if only Certified OK files are allowed, the button will be disabled.

+ The Send button allows to continue sending the PDF file to the server defined in the
Connector. This button will not be available if the preflight returns Errors, and the Connector
is set to not accept files that are not Certified 0K.

7.4 Delivering other files

If the creator of the PitStop Connector has allowed it, it is possible to deliver other files than PDF
files using a PitStop Connector.

If the type of file you dropped on the Connector is not allowed, an error message will be displayed.

7.5 Delivering multiple jobs or folders

Delivering a folder

If non PDF files are allowed for the connector, you can deliver a job folder via the connector. In
that case, the Connector will offer the choice between delivering the folder as a single job folder
(without preflighting or any processing), or processing the files in the folder as multiple separate
jobs (see below).

If non PDF files are not allowed, the Connector will not accept folders.

Delivering multiple jobs

When multiple jobs (or multiple folders) are dropped on the connector, these jobs will be processed
one by one. The files are put in a queue, shown in the progress window.
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The only difference with dropping the files on the Connector one by one, is that the login user
name and password (if required by the Connector) will only need to be entered once, for the
first job.

7.6 Handling errors

It is possible that you receive an error message after dropping a file on the Connector. If you
receive a Preflight error, you may still be able to to deliver your file. A Configuration error has
to be fixed first.

Configuration errors
The following configuration errors might occur:
Could not connect to the Enfocus Switch server
* Could not connect to the FTP server
Limit of client licenses reached
* Submit point not active anymore

In all the cases mentioned above, you should contact your printer/publisher and state the specific
error message you received.

If you receive the following error:
Password was not filled in or wrong password was given

Please fill in the correct password and proceed.

Preflight errors
If you receive a Preflight error, do one of the following:

* (lick Cancel. Correct the errors in you source file or correct your PDF file using PitStop Pro (see
www. enfocus.com > Products > PitStop Pro for more information). Drop the new or corrected
file on the Connector.

Click Sign-off... to Sign Off on the Preflight error(s) (see also To Sign Off on Preflight errors on
page 28).

*  (lick Continue to proceed to deliver the file (only possible if authorized by the creator of the

Connector).

To Sign Off on Preflight errors

If the Preflight results in errors, an error message is displayed.

You can Sign Off on these Preflight errors by doing the following:
1. Click Sign Off...
2. Optionally, provide information on the reason for Sign-off.

3. Confirm your personal Sign-off.
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8. Advanced topics

8.1 Distributing PitStop Connectors

A PitStop Connector consists of one file only, which can be placed anywhere on the user's
computer. For instance, the desktop might be a convenient location.

You can distribute you PitStop Connectors in various ways:

FTP
+ Web site
+ (D

8.2 About Preflight Profiles

"Preflighting" is the process of checking a PDF document against various criteria to ensure that
the PDF document meets all the requirements for output or publication. Typically, the criteria
vary depending on the output or publishing process. A set of criteria matching the requirements
of a particular process is called a Preflight Profile.

To download a Preflight Profile

You can download a Preflight Profile from the Enfocus website:

1. Go to www.enfocus.com > Support > Preflight Profiles.

2. Download the desired Preflight Profile.

Creating Preflight Profiles

You can create your own Preflight Profiles, or edit existing profiles, using Enfocus PitStop Pro,
PitStop Extreme, PitStop Server or PitStop Connect.

Go to www.enfocus.com > Products to find out more about these Enfocus products.
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8.3 About Action Lists

An Action List is a series of sequential tasks saved in one file. For example, tasks such as changing
color or objects. Using Action Lists, the tasks will be carried out in the defined sequence. Action
Lists can be saved and used again, saving time otherwise spent on repetitive tasks.

To download an Action List

You can download Action Lists from the Enfocus website:

1. Go to www.enfocus.com > Support > Action Lists.

2. Download the desired Action List.

Creating Action Lists

To create your own Action Lists, you need Enfocus PitStop Pro or PitStop Extreme.
Go to www.enfocus.com > Products to find out more about these Enfocus products.

Also see the Action List Manual.

8.4 About Enfocus Switch

Using Enfocus Switch, you can easily integrate automated Preflight, correction and certification
of PDF files into a larger automated workflow. Enfocus Switch is capable of automatically receiving
jobs through email, FTP or directly from PitStop Connect, of sorting and routing jobs based on
file type or naming conventions, and of automating a complete range of key professional
publishing applications. This allows a smooth integration of the Enfocus Preflight technology
with PDF file creation, color conversion, image optimization, imposition and proofing tools.
Simply integrate Adobe Acrobat Distiller, Enfocus PitStop Server, QuarkXPress and many other key
publishing applications into your flows.

There are three Switch product flavors: LightSwitch, FullSwitch and PowerSwitch.

Go to www.enfocus.com > Products > Switch to find out more about this Enfocus product.

30


http://www.enfocus.com/contentpage.php?id=929
http://www.enfocus.com/contentpage.php?id=863
http://www.enfocus.com/action_list_manual.php
http://www.enfocus.com/contentpage.php?id=5507
http://www.renderx.com/
http://www.renderx.com/reference.html
http://www.renderx.com/tools/
http://www.renderx.com/

Index

A

Action Lists
about 30
create 30
download 30

Advanced topics 29

C

Connector

components 25, 26

create 21

distribution 29

drop a file 26

installation 25

menu 26

use 25, 26

window overview
components 25

Connector project

Color properties 19

create 17

duplicate 23

edit 24

manage 23

new 17

projects list 14

properties 15, 18, 19, 20
Definition properties 18
Delivery properties 20
Preflight properties 18
Window properties 18

remove 23
D
Delivery
errors 28
other files 27
E
Enfocus Switch
about 30
Errors
handle 28
Preflight
Sign-off 28
G

Getting started 25

Help 5

Installation 6, 25
Connector 25
download installer 6
locate installer 6
PitStop Connect 6

Introduction 5

L

License 7, 8,9
activation 7, 8, 9
move 9

P

PitStop Connect
application components 12
application menu 15
finding your way 1
help 5
installation 6
introduction 5
main window overview 12

run 6
trial 7
Preflight Profiles
about 29
create 29
download 29
T
Trial 7, 8
on-line 8
start 8
W
Workspace 12, 13, 14, 15
menu 15
overview 12

project properties 15
projects list 14
toolbar 13

Index


http://www.renderx.com/
http://www.renderx.com/reference.html
http://www.renderx.com/tools/
http://www.renderx.com/

	Contents
	1. Copyrights
	2. Introduction
	2.1 Welcome to PitStop Connect
	2.2 Using PitStop Connect help

	3. Installing and running PitStop Connect
	3.1 Getting ready to run PitStop Connect
	Locating the installer from a product DVD
	Downloading the installer from internet
	Installing PitStop Connect

	3.2 Running PitStop Connect for the first time
	3.3 Licensing
	Creating an activation account
	Starting a trial
	Starting a trial on-line

	Activating licenses
	On-line activation

	Moving licenses between computers


	4. Finding your way around PitStop Connect
	4.1 PitStop Connect: the general concept
	Updating Connectors

	4.2 PitStop Connect application components
	Main window overview
	Toolbar
	Connector projects list
	Connector project properties

	Menu


	5. Creating a Connector project
	5.1 Creating a new project
	To create a new project

	5.2 Setting the project properties
	Definition properties
	Window properties
	Preflight properties
	Color properties
	Delivery properties
	Update properties

	5.3 To create a PitStop Connector

	6. Managing Connector projects
	6.1 To remove a project
	6.2 To duplicate a project
	6.3 To edit a project

	7. Using a PitStop Connector
	7.1 Getting started
	To install a PitStop Connector
	Check for updates

	7.2 PitStop Connector components
	Window overview
	Menu

	7.3 Using a PitStop Connector to send a PDF file
	To drop a file on a Connector

	7.4 Delivering other files
	7.5 Delivering multiple jobs or folders
	7.6 Handling errors
	To Sign Off on Preflight errors


	8. Advanced topics
	8.1 Distributing PitStop Connectors
	8.2 About Preflight Profiles
	To download a Preflight Profile
	Creating Preflight Profiles

	8.3 About Action Lists
	To download an Action List
	Creating Action Lists

	8.4 About Enfocus Switch

	Index

